Contents

Abstract ................................................................................................................................................................................1
Introduction .............................................................................................................................................................................1
Purpose and Scope ...............................................................................................................................................................2
System Requirements .............................................................................................................................................................2
Installation ...........................................................................................................................................................................2
User Interface .......................................................................................................................................................................3
Tabs ....................................................................................................................................................................................3
Well Info Tab ......................................................................................................................................................................4
Water-Level Info Tab ..........................................................................................................................................................6
Menus ..................................................................................................................................................................................7
File Menu ...........................................................................................................................................................................8
Data Menu .........................................................................................................................................................................9
Observation Menu ..............................................................................................................................................................10
Chart Menu .......................................................................................................................................................................12
Table Menu .......................................................................................................................................................................12
Major HObO Tasks ............................................................................................................................................................13
Edit Flags Task .................................................................................................................................................................13
Set Water-Level Flags Task ..............................................................................................................................................15
Set Multiple Wells Flags Task ...........................................................................................................................................16
Import Data task ................................................................................................................................................................18
Observations Task ..............................................................................................................................................................22
Tutorial ................................................................................................................................................................................24
Create a New HObO Database ......................................................................................................................................25
Open an Existing HObO Database ................................................................................................................................27
Load NWISWeb Data into HObO Database ..........................................................................................................................29
Retrieving NWISWeb Data Using the HObO_NWISWeb Utility ......................................................................................30
Importing NWISWeb Data Retrieved Using the HObO_NWISWeb Utility .................................................................32
Creating a New Well Flag and Setting it for a Well ..............................................................................................................33
Looking at Water-Level Data for a Well ............................................................................................................................35
Zooming into an Area on the Hydrograph ........................................................................................................................36
Zooming to the Full Hydrograph Area ...............................................................................................................................37
Turning Hydrograph Data Points On and Off ....................................................................................................................38
Turning Hydrograph Key On and Off ................................................................................................................................39
Selecting Multiple Water-Level Records from the Hydrograph ......................................................................................40
Adding New Primary Water-Level Flags ........................................................................................................................42
Adding New Secondary Water-Level Flags ......................................................................................................................44
Changing Primary Water-Level Flag for a Single Record .................................................................................................46
Changing Secondary Water-Level Flags for a Single Record ...........................................................................................47
Changing Primary and Secondary Water-Level Flags for Multiple Records .................................................................49
Updating Location Values of Wells by Importing a dbf Table ............................................................................................52
Adding New Water-Level Altitude and Depth Data From a Comma-Separated Text File ..................................................55
References Cited .................................................................................................................................................................58
Figures

Figure 1. The HObo Program window, showing tabs and menus ................................................................. 3
Figure 2. The well information pane for multi-well information. ................................................................. 5
Figure 3. The HObo Program window, showing tabs and menus ............................................................... 6
Figure 4. HObo Options window .............................................................................................................. 10
Figure 5a. Edit Flags task window for Well and Primary Water-Level flags .............................................. 14
Figure 5b. Edit Flags task window for Secondary Water-Level flags ....................................................... 15
Figure 6. The Set Water-Level Flags task window of HObo ................................................................. 16
Figure 7. The Set Multiple Wells Flags task window of HObo ................................................................. 18
Figure 8. Import Data task window of HObo ........................................................................................... 21
Figure 9a. The Observations task window of HObo ................................................................................. 23
Figure 9b. Sample observation periods ................................................................................................... 24
Figure 10a. Open file window to select an existing HObo database ....................................................... 60
Figure 10b. Save file window to specify a name to save the retrieved data ........................................... 61
Figure 10c. Progress window showing the status of data being retrieved from NWISWeb ................. 61
Figure 11a. NWISWeb toolbar with the NWISWeb command ............................................................... 62
Figure 11b. Steps to turn on the NWISWeb extension in ArcMap .......................................................... 63
Figure 11c. ArcMap Extension window .................................................................................................... 64
Figure 12. Save file window to specify the site shapefile name .............................................................. 65
Figure 13. Results of the retrieval from NWISWeb .................................................................................. 66
Tables

Table 1. Observation File .............................................................................................................................................11
Table 2a. Import Data task description of well fields ...................................................................................................22
Table 2b. Import Data task description of water-level fields ..................................................................................22
Table 3. Fields populated by the ArcGIS NWISWeb Extension ..................................................................................67
Table 4. Tables created by HObO ..............................................................................................................................68
Head Observation Organizer (HObO)

By Steven Predmore

Abstract

The Head Observation Organizer, HObO, is a computer program that stores and manages measured ground-water levels. HObO was developed to help ground-water modelers compile, manage, and document water-level data needed to calibrate ground-water models. Well-construction and water-level data from the U.S. Geological Survey National Water Database (NWIS) easily can be imported into HObO from the NWIS web site (NWISWeb). The water-level data can be flagged to determine which data will be included in the calibration data set. The utility program HObO_NWISWeb was developed to simplify the down loading of well and water-level data from NWISWeb. An ArcGIS NWISWeb Extension was developed to retrieve site information from NWISWeb. A tutorial is presented showing the basic elements of HObO.

Introduction

Development of ground-water flow models often requires the compilation of large ground-water-level data sets. Water levels selected from these data sets are used for observations in the calibration of the ground-water flow model. The process of selecting water levels suitable for model calibration often is laborious, subjective, and undocumented. The Head Observation Organizer (HoBO) was developed to aid in the selection, management, and documentation of the water-level observations. HObO stores well and water-level information as tables in an Environmental Systems Research Institute (ESRI) personal geodatabase. The tables created by HObO are listed in Appendix 3. HObO allows the user to select and annotate water-level information with flags. A flag is a code in the database to identify the primary and secondary category which a water-level measurement represents and to keep a record of the reasoning behind the selection. These hierarchical flags then can be used to select a subset of water levels for output for a variety of uses, such as ground-water modeling observations. Well construction and water-level data from the U.S. Geological Survey National Water Database (NWIS) easily can be imported into HObO from the NWIS web site (NWISWeb). The utility program HObO_NWISWeb was developed to simplify down loading well and water-level data from NWISWeb. An ArcGIS NWISWeb Extension was developed to retrieve site information from NWISWeb. ArcGIS NWISWeb Extension, is a tool that runs inside ArcGIS ArcMap to retrieve wells on the basis of the map extent from NWISWeb and to create a shapefile of the retrieved data.
Purpose and Scope

The purpose of this report is to document the computer program, HObO, and provide a tutorial on how to use the program. The report includes a description of the utility programs HObO_NWISWeb and ArcGISNWISWeb Extension that were developed to retrieve data from NWISWeb for importation into HObO. This report was written with the assumption that the reader has a basic understanding of GIS, graphical interfaces, and computer utilities.

System Requirements

HObO requires Microsoft Windows XP Professional Edition with ESRI ArcGIS Engine runtime Version 9.2. Additional system requirements can be found on the ESRI support website at ESRI (2007) under the Knowledge Base tab. Microsoft .NET Framework Version 2.0 is required to run HObO and typically is installed with most software written since 2005. If not, it is free and can be obtained from Microsoft (2007) at http://www.microsoft.com/downloads. ESRI ArcGIS 9.2 Engine runtime or one of the ArcGIS 9.2 desktop products ArcInfo, ArcEditor, or ArcView must be installed to run HObO. ArcGIS 9.2 Engine can be obtained from ESRI (2007). The minimum ESRI license required to run HObO is the ArcGIS Engine license but HObO will take advantage of any of the ESRI ArcGIS desktop licenses that are available. Although HObO will run without internet connection, an internet connection is necessary to take full advantage of retrieving data from USGS NWISWeb.

Installation

Before installing HObO, make sure that the Microsoft .NET Framework Version 2.0 and ESRI ArcGIS Engine runtime Version 9.2 or other ESRI ArcGIS 9.2 desktop product is installed. HObO is provided with a standard windows installer program. Obtain a copy of the HObOInstaller.msi installation file from http://pubs.water.usgs.gov/of2007-1383/ and place a copy on your computer. Double click on the HObOInstaller.msi file and the installer program will commence.
User Interface

The HObO user interface consists of two tabs (Well Info, and Water-Level Info), five menus (File, Data, Observation, Chart, and Table) and five task windows (Edit Flags, Set Water-Level Flags, Set Multiple Wells Flags, Import Data, and Observations). The two tabs and menus are located near the top of the main program window. Each tab is separated into two panes, while each menu provides a drop-down list of commands (fig. 1). Grayed out tabs, menus and commands are inactive. The name of the current database is indicated at the lower right corner of the program window.

Figure 1. The HObO Program window, showing tabs and menus. The Well Info tab is selected.

Tabs

HObO has two tabs: the Well Info tab and the Water-Level Info tab (fig. 1). The Well Info tab is where well-specific tasks are performed, and the Water-Level Info tab is where water-level-specific tasks are performed.
Well Info Tab

The Well Info tab is divided vertically with a map pane on the left and a well information pane on the right, dividing the geographic information from the tabular information (fig. 1).

Map Pane

The map pane displays the study area and graphics tools. The pane is composed of the map toolbar, map table of contents, and the map itself (fig. 1).

Map Toolbar

The map tools in the map toolbar at the top of the map pane consist of four map tools and seven map commands. A map tool allows a user to interact with the map. A map command allows a user to interact with the entire map. These tools and commands are based on the ESRI map tools and commands (ESRI, 2007).

The first three buttons on the toolbar are navigation tools, and are composed of the Zoom-in tool (Zoom-in), the Zoom-out tool (Zoom-out), and the Pan tool (Pan). Selecting the Zoom-in tool (Zoom-in) and dragging a box on the map will zoom to that area. Selecting the Zoom-out tool (Zoom-out) and dragging a box on the map will zoom out. Selecting the Pan tool (Pan) and dragging the map will pan the map.

The Full extent, Previous extent, and Next extent commands allow for navigating selected views. Selecting Full extent displays the entire map. Selecting Previous extent zooms back to the last extent. Selecting Next extent re-zooms to the next extent.

The Select tool is used to select wells from the map. Use the Select tool to select one well by clicking on it or select a group of wells by dragging a box around the wells.

The Select all, Clear selection, and Switch selection commands allows the user to change selected features. Selecting Select all selects all the wells. Selecting Clear selection clears all the selected well so no wells are selected. Selecting Switch selection makes the selected wells unselected and the unselected wells selected.

The Refresh map command will force the map to be redrawn.

Map Table of Contents

The map table of contents shows the different geographic layers that are displayed on the map. The layers can be displayed or hidden by checking or unchecking the checkbox next to the layer of interest.

Map

The map shows the spatial distribution of the wells in relation to the study area. Optionally, if an ArcMap document (.mxd) is defined, other geographic layers such as roads and images can be included on the map.

Well Information Pane

The well information pane is where the user interacts with the well information. If there are no wells selected or if only one well is selected, the pane will display single well information (fig. 1). If multiple wells are selected, multi-well information is displayed (fig. 2).
Figure 2. The well information pane for multi-well information.

Single-Well Information

When a single well is selected, information about the well is displayed in the single-well information display. The right side of figure 1 shows single-well information for the well information pane. A well can be selected using the WellID dropdown, the Common name dropdown, or be selected interactively from the map. A well flag can be changed by clicking on the Well flag dropdown and clicking on the Update data button on the lower right of the pane. New flags can be added to the list by clicking on the Add well flag button. Source data can be viewed by clicking on the View source button. Comments specific to the well can be added by entering text in the Comments box and clicking the update data button. Comments are notes that are not used for selecting a well, and are for informational purposes only.
Multi-Well Information

When multiple wells are selected, the multi-well information is displayed. Multiple wells can be selected by using the Select tool from the map toolbar and holding the left mouse button down while dragging a box around the wells to select. All the wells can be selected by using the Select all command on the map toolbar. The right side of figure 2 shows multi-well information for the selected wells. A list of currently selected wells is displayed with check boxes next to them. To select a single well from the list to edit water-level flags, right click on the well and select Edit water-level flags from the pop up menu. To edit the properties of a single well from the list, right click on the well and select Select this well from the pop-up menu. Well flags for all the selected wells can be set as a group by making sure the interested wells are checked in the list and by clicking on the Flag wells button at the lower right of the pane. Well and water-level flags can be specified uniformly from the Set Multiple Wells Flags task window if multiple wells and the Flag wells button are checked.

Water-Level Info Tab

The Water-Level Info tab is where water-level flagging tasks are performed. This tab is divided up horizontally with a graph pane on the top and a data pane on the bottom (fig. 3).

Figure 3. The HObO Program window, showing tabs and menus. The Water-Level Info tab is selected.
Graph Pane

The hydrograph of the selected well is displayed in the graph pane (fig. 3). When the mouse cursor is moved over a data point, the record in the data pane is highlighted. The user can magnify an area of the graph by left clicking on the upper left side of the area of interest and dragging a box to the lower right. The user can zoom out to the full extent of the graph by left clicking on the upper left side of the area of interest and dragging a box to the upper left. Data series are plotted if the boxes in the explanation are checked. Settings for how the graph key is displayed can be changed in the Chart menu.

The data points are grouped by the primary flags of the water-level record. A flag can be set for an individual data point by right clicking on the data point in the graph and selecting the Edit flags command from the popup menu. This will open the Set Water-Level Flags task window allowing the user to set the primary and secondary flags. Multiple water-level records can be selected on the chart by right clicking on the graph and selecting the Select records command. This will put the graph in select records mode. Once in the select records mode, multiple records can be selected by left clicking on the graph and dragging a box around the desired water-level records. The select records mode is active as long as there is a check next to the Select records command.

Data Pane

The data pane shows a data grid (spreadsheet) view of the water-level data (fig. 3). The fields shown in the table can be changed by changing the visibility of the fields in the Chart menu. The primary flag for each water-level record can be changed by clicking on the dropdown in the primary flag field. Flags of the selected records can be set by right clicking on a selected record and selecting the Edit flags command from the popup menu. This will open the Set Water-Level Flags task window allowing the user to set the primary and secondary flags. The source data can be viewed by right clicking on a record in the data grid view and selecting the View source command from the popup menu. A popup window with a table of the originally imported data will be displayed.

Menus

The HObO interface has File, Data, Observation, Chart, and Table menus (fig. 3). The File menu has commands for file management and importing ArcMap Documents (MXD files). The Data menu has commands for importing new data into the HObO database and setting options on displaying the data. The Observation menu has commands for exporting observation files. The Chart menu has commands for setting the chart viewing options. The Table menu has commands for setting the table viewing options.
File Menu

The File menu has **Open**, **New**, **Load MXD**, **Save**, and **Exit** commands (fig. 3). The **Open** command opens an existing HObO database. The **New** command creates a new HObO database. The **Load MXD** command loads an ESRI ArcMap Document (MXD file). The **Save** command saves the current HObO database. The **Exit** command exits HObO.

**Open Command**

The **Open** command displays an open file window for the user to select the HObO database to open. When a database is selected, HObO will check the database file to make sure the necessary tables are in the database. If the database is a valid HObO database, the program will open the database. Then a window will be opened telling the user that the database was opened successfully. If the database is not a valid HObO database, an error message is returned to the user. A valid HObO database consists of the 13 tables listed in appendix 3 of this report.

**New Command**

The **New** command initiates the process of creating a new HObO database. First, a create file window is displayed for the user to enter a file name to create. Once the name is entered, a new HObO database is created.

**Load MXD Command**

The **Load MXD** command imports an ESRI ArcMap Document (MXD file). A window is displayed for the user to select an MXD file to add to the HObO database and displayed in the Map pane of the Well Info Tab.

**Save Command**

The **Save** command saves the current settings in the HObO database.

**Exit Command**

The **Exit** command cleans any temporary tables and terminates HObO.
Data Menu

The Data menu has Get from NWISWeb, Import NWISWeb data, Import from table, and Options commands (fig. 3). The Get from NWISWeb command retrieves data from the NWISWeb site. The Import NWISWeb data command imports XML data saved from running the HObO_NWISWeb utility (append. 1). The Import from table command imports data from several common database file types.

Get from NWISWeb Command

The Get from NWISWeb command retrieves the well data and water-level data from the NWISWeb site. Once initiated, a window will be displayed informing the user of the status of the retrieval. When completed, a window will be displayed informing the user of the successful download. If the program cannot download data from the NWISWeb site, a window will be displayed notifying the user of the problem.

Import NWISWeb data Command

Although HObO is designed to import NWISWeb data, many data sets take large amounts of time to download. To separate this task, the HObO_NWISWeb utility, documented in Appendix 1, was developed so that the downloading task could be performed separately from HObO, thereby allowing the user to continue flagging water levels. The HObO_NWISWeb utility stores the retrieved data in an XML file. The Import NWISWeb data command imports the XML file that was created by the HObO_NWISWeb utility. Selecting the Import NWISWeb data command will display an open file window for the user to select the XML file. Once an XML file is selected, a window will be displayed informing the user of the status of the import. Once completed, a final window will be displayed informing the user of the successful import.

Import from table Command

The Import from table command imports dBase files and comma-separated files through the Import Data task window.
**Options Command**

The **Options** command sets options on how the “common name” of the well is displayed. When the **Options** command is clicked, the **HObO Options** window is displayed (fig. 4). The Options window allows the user to specify a column to sort the common name by. This was done because some of the common names were made up of the 15-character state well number with a local name appended, and this option would allow the user to see the common name sorted by the local name rather than by the state well number. The window also allows the user to display the common name in the multi-well information pane instead of in the well id field, by checking the check box.

![HObO Options window](image)

**Figure 4.** HObO Options window.

**Observation Menu**

The **Observation** menu has the **Make observation file** command (fig. 3). This command creates an observation file. This observation file contains all the necessary information to create a MODFLOW 2000 Hydrologic-Head Observation (HOBs) file (Hill and others, 2000). In future versions, there are plans to support other observation file formats that will be listed in the Observations menu.

![Head Observation Organizer](image)

**Make observation file Command**

The **Make observation file** command creates an observation file. The **Observation** task window is displayed for the user to select the parameters for the observation file. Once the parameters are set, the observation file is created. Table 1 is a list of column headings and a brief description of each of the columns created in the observation file. The default weight of an observation is 1. Currently, the only way to change the weight of an observation is by importing new values using the **Import Data** task window.
Table 1. Observation File.

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WellID</td>
<td>Well id of the observation</td>
</tr>
<tr>
<td>ObsName</td>
<td>Observation name</td>
</tr>
<tr>
<td>XLocation</td>
<td>x location in decimal degrees</td>
</tr>
<tr>
<td>YLocation</td>
<td>y location in decimal degrees</td>
</tr>
<tr>
<td>TopOfPerf</td>
<td>Top of perforation in input units</td>
</tr>
<tr>
<td>BottomOfPerf</td>
<td>Bottom of perforation in input units</td>
</tr>
<tr>
<td>ObsStart</td>
<td>Beginning date of the observation period</td>
</tr>
<tr>
<td>ObsEnd</td>
<td>Ending date of the observation period</td>
</tr>
<tr>
<td>Cnt_WellID</td>
<td>Number of observation in the observation period</td>
</tr>
<tr>
<td>Min_WaterLevelDep</td>
<td>Minimum depth to water</td>
</tr>
<tr>
<td>Ave_WaterLevelDep</td>
<td>Average depth to water</td>
</tr>
<tr>
<td>Max_WaterLevelDep</td>
<td>Maximum depth to water</td>
</tr>
<tr>
<td>SD_WaterLevelDep</td>
<td>Standard deviation of the depth to water measurements</td>
</tr>
<tr>
<td>Min_WaterLevelAlt</td>
<td>Minimum water-level altitude</td>
</tr>
<tr>
<td>Ave_WaterLevelAlt</td>
<td>Average water-level altitude</td>
</tr>
<tr>
<td>Max_WaterLevelAlt</td>
<td>Maximum water-level altitude</td>
</tr>
<tr>
<td>SD_WaterLevelAlt</td>
<td>Standard deviation of the water-level altitude</td>
</tr>
<tr>
<td>Min_ObsWeight</td>
<td>Minimum observation weight</td>
</tr>
<tr>
<td>Ave_ObsWeight</td>
<td>Average observation weight</td>
</tr>
<tr>
<td>Max_ObsWeight</td>
<td>Maximum observation weight</td>
</tr>
<tr>
<td>SD_ObsWeight</td>
<td>Standard deviation of the observation weight</td>
</tr>
<tr>
<td>Min_PrimaryFlag</td>
<td>The first primary flag</td>
</tr>
</tbody>
</table>
Chart Menu

The Chart menu allows the user to change settings for the hydrograph. With the hydrograph, the user can easily see potential problems with observed water-levels. The Chart menu has Show Key and Show Short Key commands (fig. 3). The Show Key command toggles the more descriptive primary flag key. The Show Short Key command toggles the key with the abbreviated three character primary flag code. The flag code is a user-defined three-character key stored in the database used to flag the data. Each of the three-character flag codes has a user-defined lengthier description associated with it.

Show Key Command

The Show Key command controls the visibility of the descriptive primary flag key. If a check appears next to the Show Key command, the descriptive primary flag key is being displayed, and selecting this command will turn the chart key off. If a check does not appear next to the Show Key command, the descriptive primary flag key is not being displayed and selecting this command will turn on the descriptive primary flag key.

Show Short Key Command

The Show Short Key command controls the visibility of an abbreviation for the primary flag code. If a check appears next to the Show Short Key command, a three-character primary flag code abbreviation is being displayed and selecting this command will turn off the chart key. If a check does not appear next to the Show Short Key command, the abbreviation is not being displayed and selecting this command will turn on the abbreviated key.

Table Menu

The Table menu choices are: Show WellID, Show Data Source, and Show Source Date commands (fig. 3). All three of these commands toggle the visibility of the relevant field in the table.
Show WellID Command

The Show WellID command toggles the visibility of the WellID field in the table. If a check appears next to the Show WellID command, the WellID field in the table is visible and selecting this command will hide the WellID field from the data pane. If a check does not appear next to the Show WellID command, the WellID field in the table is not visible and selecting this command will show the WellID field in the data pane.

Show Data Source Command

The Show Data Source command toggles the visibility of the DataSource field in the table. If a check appears next to the Show Data Source command, the DataSource field in the table is visible and selecting this command will hide the DataSource field from the data pane. If a check does not appear next to the Show Data Source command, the DataSource field in the table is not visible and selecting this command will show the DataSource field in the data pane.

Show Source Date Command

The Show Source Date command toggles the visibility of the SourceDateTime field in the table. If a check appears next to the Show Source Date command, the SourceDateTime field in the table is visible and selecting this command will hide the SourceDateTime field from the data pane. If a check does not appear next to the Show Source Date command, the SourceDateTime field in the table is not visible and selecting this command will show the SourceDateTime field in the data pane.

Major HObO Tasks

The HObO user interface consists of five major tasks: the Edit Flags task, the Set Water-Level Flags task, the Set Multiple Wells Flags task, the Import Data task, and the Observations task. Each of these tasks opens a separate window that is designed for entering information for the specific task.

Edit Flags Task

The Edit Flags task is used to manage the well flags, primary water-level flags, and secondary water-level flags. A water-level flag is a code in the database to identify the primary and secondary category that a water-level measurement represents, and to keep a record of the reasoning behind the selection. These hierarchical water-level flags then can be used to select a subset of water levels for output for a variety of uses, such as ground-water modeling observations. HObO can have one primary, and up to 10 secondary, water-level flags for each water-level measurement. A well flag is used to classify each well into a user defined group that can be used to select water-levels when making ground-water modeling observations. The Edit Flags task window is made up of a data grid (spreadsheet) and four buttons. The buttons are Add, Delete, Update, and Cancel.
The data grid has two or three columns, depending on the type of flag to be managed. There are three columns for the well and primary water-level flags (fig. 5a) and there are two columns for the secondary water-level flags (fig. 5b). The first column with the heading Flag holds the three-character flag that will be stored in the database. The second column with the heading Description holds up to an 80-character description of the flag that will show in the dropdown lists. The third column with the heading Color holds the color setting for the flag. For the well flag, the color will be used to symbolize the well on the map. For the primary flag, the color will be used to symbolize points on the graph and to color the text in the data grid.

To add a new flag, click on the Add button. This will add a new row to the data grid, which can be edited with the three-character flag, description, and color, if applicable. To delete a flag, select the flag to delete in the data grid then click on the Delete button. A warning will be displayed telling the user that deleting a flag in use in the database can cause the database to be corrupted and possibly unusable. If a flag is deleted and reference to the flag is in the tables, the database will be corrupted. If the user still wants to delete the flag, it will be deleted.

Flag data can be edited by changing the appropriate box in the data grid. It is not advisable to edit the three-character flag because if the flag still is being used in the database, changing the flag may cause the database to become corrupted and possibly unusable.

Finally, click on the Update button to store the changes into the database. The operation can be canceled by clicking on the Cancel button.

![Edit Flags](Figure 5a. Edit Flags task window for Well and Primary Water-Level flags.)
Figure 5b. Edit Flags task window for Secondary Water-Level flags.

Set Water-Level Flags Task

The Set Water-Level Flags task window is divided into three sections: the primary flag section at the top, the secondary flag section in the middle, and a comment box and button at the bottom (fig. 6).

The primary flag section at the top is composed of a dropdown box in which the user can select a primary flag. To add a new primary flag, click on the Add flag button next to the dropdown box. This will open the Edit Flags task window allowing the user to edit the primary flags.

The secondary flag section in the middle is made of a checklist where different combinations of secondary flags can be selected. To add a secondary flag, click on the Add flag button next to the checklist. This will open the Edit Flags task window allowing the user to edit the secondary flags.

Comments can be tied to the water level by entering the comments in the textbox at the bottom of the form in the comments section. When the desired changes are made, click on the Update button to store the changes into the database. To cancel without storing the changes, click on the Cancel button.
The Set Water-Level Flags task window of HObO.

**Set Multiple Wells Flags Task**

The **Set Multiple Wells Flags** task is used to set well flag, water-level primary flag and/or secondary flags for multiple wells. Multiple wells can be selected by using the **Select** tool and dragging a box around the wells of interest or by using the **Select all** command to select all the wells. The **Set Multiple Wells Flags** task window is split into five sections: **Select wells** section, **Current well flag** section, **Current water-level flag** section, **Set new well flag** section, and **Set new water-level flags** section (fig. 7). **Select wells** section is used to refine the selection of wells to be flagged. The **Current well flag** section and **Current water-level flag** section are used to further refine the selection of wells or water levels to be flagged, by restricting the flagging to be applied to the wells or water levels that already have been flagged with a specific flag.
The **Select wells** section is composed of a list of the currently selected wells. The flagging done in the task window is applied only to the wells in the list with a check next to it. The user can refine the selection of wells by unchecking wells. The check marks are toggled on and off by clicking on the wells in the list. The wells in the list without a check mark next to it will be ignored and not be flagged.

The **Current well flag** allows the user to further refine the wells that will be flagged. If the first radio button with the caption *Use all wells regardless of current flag:* is selected, no further refinement of the wells selected in the **Select wells** section will be made. If the second radio button with the caption *Use only wells currently flagged as:* is selected, the dropdown box becomes active and a well flag must be selected. This will further refine wells selected in the **Select wells** section to those with the well flag already set to the flag selected in the dropdown box.

The **Current water-level flag** section allows the user to refine the water levels that will be flagged. If the first radio button with the option *Use all water levels regardless of current flag* is selected, no further refinement of the water-level records for the wells selected in the **Select wells** section will be made. If the second radio button with the option *Use only water-levels currently flagged as* is selected, the dropdown box becomes active and a primary water-level flag must be selected. This will further refine water-level records for the wells selected in the **Select wells** section to those with the primary water-level flag already set to the flag selected in the dropdown box.

The **Set new well flag** section sets a new well flag to the selected wells. To set a new well flag, the **Set new well flag** check box must be checked and one of the well flags must be selected from the dropdown box. A new well flag can be added by clicking on the **Add flag** button next to the dropdown box, which will open the **Edit Flags** task window, allowing the user to edit the well flags.

The **Set new Water-level flags** section sets the primary and secondary flags to the selected water levels. To set a new water-level flag, the set new water-level flag check box must be checked and one of the primary water-level flags must be selected from the drop down box. Secondary flags can be selected from the checklist. New secondary flags can be added by clicking on the **Add flag** button next to the checklist. This will open the **Edit Flags** task window allowing the user to edit the secondary flags.

Clicking on the **Update** button stores the changes into the database. The operation can be canceled by clicking on the **Cancel** button.
**Figure 7.** The Set Multiple Wells Flags task window of HObO.

**Import Data task**

The **Import Data** Task is used to import external data into the database. The **Import Data** task window is made up of three major sections: import name, import type, and import fields (fig. 8). The import name associates all the settings for the import to a name. To retrieve a previously defined import, select the name from the list in the dropdown box. To define a new import, type the new import name in the box and press the Enter key. Then a window will be displayed asking the user if they want to add the new definition to the database.
The import type section is active only when a new import is being defined. The three buttons on the left part of the import type section defines the basic import type. If the radio button with the caption **Add only new data** is selected, only records that currently are not in the HObO database will be added.

If the radio button with the caption **Update current data with new data** is selected, the user will be able to update data in specific fields for each record. When this option is selected, the three radio buttons on the right side of this section become active and the user can specify the wells that will be updated. If the **Update all wells** option is selected, all wells will be updated. If **Update wells currently flagged as:** is selected and the user selects a well flag, only the wells currently flagged with the selected well flag will be updated. If **Update all wells but wells flagged as:** is selected and the user selects a well flag, all wells except the wells flagged with the selected well flag will be updated.

If the radio button with the caption **Replace existing data with new data** is selected, the user can replace the records with new records. When this option is selected, the three radio buttons on the right side of this section become active. The user then will be able to specify the wells for which records will be replaced. If the **Replace all wells** option is selected, current records for all wells will be deleted and the new records will be imported replacing the original records. If **Replace wells currently flagged as:** is selected and the user selects a well flag, current records with wells flags with the selected well flag will be deleted and the new records will be imported, replacing the original records. If the option **Replace all wells but wells flagged as:** is selected and the user selects a well flag, current records with wells flags not the same as the selected well flag will be deleted and the new records will be imported, replacing the original records.
The import fields section of the **Import Data** task window is divided into the well section on the left and the water-level section on the right. The well section is composed of the **Well file** text box on the top, a **Field separation character** text box, to be used when importing from a text file, a **Use tab separator** check box, and ten dropdown boxes to assign the imported fields to the HObO database fields (table 2a). When importing text files, the user can specify the field separator by putting the field separator character in the **Field separation character** text box. When importing text files with fields separated by tabs, click on the **Use tab separator** check box. The optional fields are identified with an italics label. The required fields are **X value field**, **Y value field**, **XY projection**, and **Well ID field**. If the radio button with the caption **Update current data with new data** in the section above is selected, a check box will be displayed in front of the field name to identify the fields to be updated.

The water-level section is composed of the import file name on the top, a **Field separation character**, a **Use tab separator** check box, a **Secondary flag separator**, a secondary flag **Use tab separator** check box that is used when importing from a text file, and eight dropdown boxes to assign the imported fields to the HObO database fields (table 2b). When importing text files, the user can specify the field separator by putting the field separator character in the **Field separation character** text box. When importing text files with fields separated by tabs, click on the **Use tab separator** check box. When importing text files with secondary flags, the user can specify the flag separator by putting the secondary flag separation character in the **Secondary flag separator** text box. This separator must be different from the field separator so the program can distinguish between the fields and the secondary flags. When importing secondary flags with fields separated by tabs, click on the secondary flag **Use tab separator** check box. The optional fields are identified with an italics label. The required fields are **Well ID field**, **WL date/time field**, **WL depth value field**, and **WL altitude value field**. If the radio button with the caption **Update current data with new data** in the section above is selected, a check box will be displayed in front of the field name to identify the fields to be updated. Just below the water-level section, a text box can be used to enter any general comments for the import. Once the appropriate fields are filled in, click on the **Import** button at the bottom. If the user wants to exit the form without importing any data, click on the **Cancel** button.
Figure 8. Import Data task window of HObO.
### Table 2a. Import Data task description of well fields.

<table>
<thead>
<tr>
<th>Well field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X value field</td>
<td>Field name with the x coordinate for the well location.</td>
</tr>
<tr>
<td>Y value field</td>
<td>Field name with the y coordinate for the well location.</td>
</tr>
<tr>
<td>XY projection</td>
<td>The projection of the coordinate system.</td>
</tr>
<tr>
<td>Well ID field</td>
<td>Field name with a unique well identifier.</td>
</tr>
<tr>
<td>Common name field</td>
<td>Field name with common name associated with the well. (optional)</td>
</tr>
<tr>
<td>Land-surface altitude value field</td>
<td>Field name with the land-surface altitude. (optional)</td>
</tr>
<tr>
<td>Top of perforation value field</td>
<td>Field name with top of perforation value. (optional)</td>
</tr>
<tr>
<td>Bottom of perforation value field</td>
<td>Field name with bottom of perforation value. (optional)</td>
</tr>
<tr>
<td>Well flag field</td>
<td>Field name with three character well flag. (optional)</td>
</tr>
<tr>
<td>Well comment field</td>
<td>Field name with comments for the well. (optional)</td>
</tr>
</tbody>
</table>

### Table 2b. Import Data task description of water-level fields.

<table>
<thead>
<tr>
<th>Water-Level field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well ID field</td>
<td>Field name with a unique well identifier to relate to a well.</td>
</tr>
<tr>
<td>WL date/time field</td>
<td>Field name with date and optionally time of the water-level measurement.</td>
</tr>
<tr>
<td>WL depth value field</td>
<td>Field name with measurement of depth to water below land surface.</td>
</tr>
<tr>
<td>WL altitude value field</td>
<td>Field name with measurement of water-level altitude above mean sea level.</td>
</tr>
<tr>
<td>WL primary flag field</td>
<td>Field name with three character primary water-level flag. (optional)</td>
</tr>
<tr>
<td>WL secondary flag field</td>
<td>Field name with up to 15 three character secondary water-level flags separated by a comma. (optional)</td>
</tr>
<tr>
<td>WL weight field</td>
<td>Field name with water-level weight value for observations. Default value is 1. (optional)</td>
</tr>
</tbody>
</table>

### Observations Task

The **Observations** task is used to create a water-level observation file. The **Observations** task window is composed of four sections: **observation name** section, **primary flag** section, **observation periods** section, and **output file** section (fig. 9a). The observation name section is composed of a dropdown box. The observation name associates all the settings for the observation to a name. To retrieve a previously defined observation, select the name from the list in the dropdown box. To define a new observation, just type the new observation name in the box and press the Enter key. Then a window will be displayed asking the user if they want to add the new definition to the database.
The **primary flag** section is composed of a checklist of primary flags. Only the water-level records that have a primary flag that matches the selected primary flags will be used to create the observation file. Multiple primary flags can be selected to make the observation file.

The observation periods section is composed of a text box and an **Import periods** button. **Import periods** button is used to import an observation periods file. When the user clicks on the **Import periods** button, an open file window is displayed for the user to select an observation periods file to import. The observation periods file is a comma-separated text file with three columns: an **observation id** column, a **start date** column, and an **end date** column (fig. 9b). The observation id is a unique id for the time period between start date and end date. Observation id will be appended to the well id field to make a unique id for each well for each observation. Once the file is selected, the textbox will be populated with the observation id, start date, and end date read from the observation periods file.

The **output file** section is composed of a text box and a button. When the button is clicked then the **save file** window appears allowing the user to specify the output file. Once the required data are entered, the user can create the output file by clicking on the **Process** button. By clicking on the **Cancel** button, user can exit the window without creating an observation file. Table 1 gives the column headings and a brief description of each of the columns created in the observation file.

![Observations](image)

**Figure 9a.** The Observations task window of HObO.
Obs1, 1/1/1980, 12/31/1984
Obs2, 1/1/1985, 12/31/1989
Obs3, 1/1/1990, 12/31/1994
Obs4, 1/1/1995, 12/31/1999
Obs5, 1/1/2000, 12/31/2009
Overlap1, 1/1/1980, 12/31/1989
Overlap2, 1/1/1990, 12/31/1999
Overlap3, 1/1/2000, 12/31/2009

Figure 9b. Sample observation periods.

Tutorial

The following tutorial guides the user through the major HObO tasks. The tutorial generally is organized in the order in which a user would perform tasks. A user may or may not need to perform all of these tasks. So that the user could easily skip to an appropriate task, the tasks are identified as separate sections.
Create a New HObO Database

To create a new HObO database with the HObO interface, follow these four steps:

1. Select the New command from the File menu.
2. When the open file window opens, specify a name for the new HObO database and click the Open button.
3. When the open file window opens again, select an existing polygon shapefile of the study area.
4. And click the Open button.
Open an Existing HObO Database

To open an existing HObO database with the HObO interface, follow these three steps:

1. Select the **Open** command from the **File** menu.
2. When the open file window opens, select a name of the HObO database and
3. Click the Open button.

A dialog window will open asking if a backup database should be made. If yes is selected, a copy of the selected HObO database will be copied in the same directory, with the date and time appended to the file name.
Backup?
Do you want to make a backup of the database now?
[Yes] [No]
Load NWISWeb Data into HObO Database

To load NWIS data into a HObO database using NWISWeb from within HObO, select the Get from NWISWeb command from the Data menu. This will retrieve NWISWeb data for the entire study area. If the study area is large or contains a large number of wells or water levels, this may take some time. For large study areas, it is recommended to retrieve the NWISWeb data using the HObO_NWISWeb utility documented in Appendix 1 and then import the data into the HObO.
Retrieving NWISWeb Data Using the HObO_NWISWeb Utility

The HObO_NWISWeb utility will retrieve NWISWeb data for the entire study area and save the retrieved data in an XML file that can be imported into HObO later. To retrieve the NWISWeb data using the HObO_NWISWeb utility follow these four steps:

1. Start the HObO_NWISWeb utility.
2. When the open file window opens, select a name of the HObO database.
3. When the save file window opens again, specify a name to save the retrieved data. The program will show a progress dialog and start requesting the data from NWISWeb.
4. Once finished close the progress dialog by clicking on the x to close the dialog.
Importing NWISWeb Data Retrieved Using the HObo_NWISWeb Utility

To import NWISWeb data from an XML file created by the HObo_NWISWeb utility follow these two steps:

1. Select the **Import NWISWeb data** command from the **Data** menu.
2. When the open file window is displayed, select the name of the XML file with the data retrieved using the HObo_NWISWeb utility.
Creating a New Well Flag and Setting it for a Well

To create a new well flag and set it to a well, follow the following ten steps:

1. Select well info tab.
2. Click on the Add Well Flag button.
3. Once the Edit Flags task window opens click on the Add button.
4. Type in a unique 3 character key to use as a flag in the flag column.
5. Type a description of the key in the description column.
6. Select a color associated with the key from the window by clicking in the cell in the Color column.
7. Click on the Update button.
8. From the Well ID dropdown box, select a well to flag.
9. Select a flag from the Well flag dropdown box.
10. Click on the Update Data button to save the changes.
### Edit Flags

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEW</td>
<td>New site.</td>
<td></td>
</tr>
<tr>
<td>UNU</td>
<td>Unused site.</td>
<td></td>
</tr>
<tr>
<td>REG</td>
<td>Regional Site</td>
<td></td>
</tr>
<tr>
<td>RIV</td>
<td>River Site</td>
<td></td>
</tr>
</tbody>
</table>

#### Step-by-Step Guide

1. **Step 3**: Add or delete flags as needed.
2. **Step 4**: Select the flag to modify.
3. **Step 5**: View and adjust the flag's description.
4. **Step 6**: Change the flag's color.
5. **Step 7**: Update the changes or cancel.
Looking at Water-Level Data for a Well

To look at water-level data for a well, follow the following two steps:

1. Select a well in the **Well ID** dropdown box.
2. Click on the **Water-Level Info** tab.

On the top pane a hydrograph will be displayed and on the bottom pane the water-level data will be displayed.
Zooming into an Area on the Hydrograph

To zoom in to an area on the hydrograph, follow the following three steps:

1. Move the mouse to the upper left corner of the area to zoom into and left click.
2. While holding the left mouse button down, drag the mouse to the lower right corner of the area to zoom into.
3. Release the mouse button.
Zooming to the Full Hydrograph Area

To zoom to the full hydrograph, follow the following three steps:

1. Move the mouse onto the hydrograph and left click.
2. While holding the left mouse button down, drag the mouse in the upper left direction.
3. Release the mouse button.
Turning Hydrograph Data Points On and Off

To turn the hydrograph data points on and off follow the following two steps:

1. To turn the data points off, click on the check box in the hydrograph key next to the data points to turn off.
2. To turn the data points on, click on the check box in the hydrograph key next to the data points to turn on.
Turning Hydrograph Key On and Off

To turn the hydrograph key, follow the following two steps:

1. To turn the hydrograph key off, click on the Show Key command from the Chart menu.
2. To turn the hydrograph key on, click on the Show Key command from the Chart menu.
Selecting Multiple Water-Level Records from the Hydrograph

To select multiple water-level records from the hydrograph, follow the following six steps:

1. Right click on the hydrograph.
2. From the pop up menu select the Select Records command.
3. Left click the mouse on the hydrograph.
4. While holding the left mouse button down, drag the mouse over the data points of interest. The records that fall inside the box that was dragged will be selected in the table.
5. Right click on the hydrograph.
6. From the pop up menu, select the Select Records command to revert back to zoom in mode.

By right clicking on the hydrograph and looking at the pop up menu, it can be determined by the check mark next to the Select Records command if the program is in zoom mode or selection mode. If the check mark appears next to the Select Records command, the program is in selection mode.
Adding New Primary Water-Level Flags

To add new primary water-level flags follow the following nine steps:

1. Right click on a record in the table.
2. Select edit flags from the popup menu.
3. From the Set water-level flags task window, click on the Add flag button next to the dropdown list of primary flags.
4. Once the Edit Flags task window opens, click on the Add button.
5. Type in a unique three character key to use as a flag in the flag column.
6. Type a description of the key in the description column.
7. Select a color associated with the key from the window by clicking in the cell in the Color column.
8. Click on the Update button on the Edit Flags task window.
9. Click on the Update button on the Set water-level flags task window to save and update the database.
Adding New Secondary Water-Level Flags

To add new secondary water-level flags, follow the following eight steps:

1. Right click on a record in the table.
2. Select edit flags from the popup menu.
3. From the Set water-level flags task window, click on the Add flag button next to the checked list of secondary flags.
4. Once the Edit Flags task window opens, click on the Add button.
5. Type in a unique three character key to use as a flag in the flag column.
6. Type a description of the key in the description column.
7. Click on the Update button on the Edit Flags task window.
8. Click on the Update button on the Set water-level flags task window to save and update the database.
Set water-level flags:

Primary flag:
New unflagged data.

Secondary flag:
- Summer measurement
- Spring measurement
- Measurement during dry year
- Measurement during wet year

Comments

Update
Cancel

Edit Flags

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUM</td>
<td>Summer measurement</td>
</tr>
<tr>
<td>SPR</td>
<td>Spring measurement</td>
</tr>
<tr>
<td>DRY</td>
<td>Measurement during dry year</td>
</tr>
<tr>
<td>WET</td>
<td>Measurement during wet year</td>
</tr>
</tbody>
</table>

Add
Delete
Update
Cancel

Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Changing Primary Water-Level Flag for a Single Record

To change the primary water level for a single record, select the new primary flag from the dropdown box in column titled **PrimaryFlag**.
Changing Secondary Water-Level Flags for a Single Record

To change secondary water-level flags for a single record, follow the following four steps.

1. Right click on a record in the table.
2. Select edit flags from the popup menu.
3. From the Set water-level flags task window, click on the check boxes to set the secondary flags.
4. Click on the Update button to save and update the database.
Changing Primary and Secondary Water-Level Flags for Multiple Records

To change primary and secondary flags for multiple records, follow the following five steps.

1. Select the records in the table by left clicking the mouse on the first record of interest, and while keeping the left mouse button down, drag the mouse to the last record of interest.
2. Once the records are selected, right click on any selected record and select the edit flags command from the popup menu.
3. From the Set water-level flags task window, set the primary flag from the Primary flag dropdown list.
4. From the Set water-level flags task window, click on the check boxes to set the secondary flags.
5. Click on the Update button to save and update the database.
Updating Location Values of Wells by Importing a dbf Table

To update location values of wells by importing a dbf table, follow the following thirteen steps.

1. Click on the **Import from table** command from the **Data** menu.
2. When the **Import data** task window appears, type a description of the import and press the enter key.
3. When the new definition window appears, click the OK button to add the new description to the database.
4. Click on the button next to the textbox for the **Well file** to select the dbf file to import.
5. Select the dbf file to import from the open file window.
6. Click on the **Update current data with new data** button.
7. Click on the **X value field** check box.
8. Select the x value field name from the **X value field** dropdown box.
9. Select the y value field name from the **Y value field** dropdown box.
10. Select the projection of the coordinates from the **XY projection** dropdown box.
11. Select the well id field name from the **Well ID field** dropdown box.
12. Click the **Import** button to import the data.
13. Once the data was imported successfully, click the **OK** button to close the successfully imported data window.
Adding New Water-Level Altitude and Depth Data from a Comma-Separated Text File

To add new water-level altitude and depth data, follow these eleven steps:

1. Click on the **Import from table** command from the **Data** menu.
2. When the **Import data** task window appears, type a description of the import and press the enter key.
3. When the new definition window appears, click the **YES** button to add the new description to the database.
4. Click on the button next to the textbox for the **Water-level file** to select the text file to import.
5. Select the text file to import from the open file window.
6. Select the well id field name from the **Well ID field** dropdown box.
7. Select the water-level date/time field name from the **WL date/time field** dropdown box.
8. Select the water-level depth field name from the **WL depth value field** dropdown box.
9. Select the water-level altitude field name from the **WL altitude value field** dropdown box.
10. Click the **Import** button to import the data.
11. Once the data were imported successfully, click the **OK** button to close the imported data window.
References Cited


Appendix 1

HObO_NWISWeb Utility

Introduction

The HObO_NWISWeb utility documented in this Appendix allows the user to retrieve data directly from NWISWeb and creates a XML file that can be imported into HObO. HObO_NWISWeb was developed so the retrieval task could be performed separately from the HObO interface. This separation allows the user to continue flagging water levels while data are being retrieved. In addition, the HObO_NWISWeb utility is designed to continually resubmit the web request when the connection times out. This resubmittal allows the retrieval to finish without user intervention.

HObO_NWISWeb utility is installed at the same time as HObO. See the Introduction section of this report for instructions and system requirements.

Running HObO_NWISWeb Utility

First, the HObO_NWISWeb utility requires a HObO database in order to determine the extent of data to request from NWISWeb. When the program is started, an Open file window pops up and the user is asked to select a HObO database (fig. 10a). After selecting a HObO database, the utility will open a save file window for the user to specify an output file name and select a location for the file to be saved (fig. 10b). Finally, a window will open showing the progress of the retrieval process (fig. 10c). Once the retrieval is complete, a message window will tell the user that the download is complete. The retrieved data can be imported into HObO using the Import NWISWeb data command under the Data menu of HObO.
**Figure 10a.** Open file window to select an existing HObO database.
**Figure 10b.** Save file window to specify a name to save the retrieved data.

**Figure 10c.** Progress window showing the status of data being retrieved from NWISWeb.
Appendix 2

ArcGIS NWISWeb Extension

Introduction

Querying data from the NWISWeb is difficult when using geographic information systems (GISs), such as ArcMap. To simplify this task, an ArcMap tool was developed to utilize the geographical capabilities of ArcGIS to determine the geographic extent of the data needed. The ArcMap tool retrieves the data from NWISWeb, and creates a point shapefile that is imported into ArcMap. This shapefile is displayed on the Map Pane of ArcMap plus a hot link that connects to the NWISWeb Site Description page for each site. This tool also allows the user to select a site and explore ground-water, surface-water, and(or) water-quality data related to the site, through use of the hot link to NWISWeb.

Installation of the NWISWeb Extension


Use of NWISWeb Extension

The NWISWeb Extension provides new capabilities to ArcMap. It packages the NWISWeb toolbar and the NWISWeb command (fig. 11a). The NWISWeb toolbar contains the NWISWeb command, and becomes visible when the extension is activated in ArcMap. To activate the extension in ArcMap, click on the Extension command from the Tools menu (fig. 11b). Once the Extension window appears, select USGS NWISWeb Extension from the list by clicking on the check box next to the extension (fig. 11c).

Figure 11a. NWISWeb toolbar with the NWISWeb command.
Figure 11b. Steps to turn on the NWISWeb extension in ArcMap.
Use of NWISWeb Command

To use the NWISWeb command, first spatial data must be loaded into the ArcMap session and the projection of the data frame defined. Once this is done, the NWISWeb command becomes active. To download NWISWeb data, zoom into the area of interest on the map and click on the NWISWeb command. A save file window will appear for the user to specify the name and location of the shapefile where the site data will be saved (fig. 12). The tool will retrieve site information based on the current extent of the map window from NWISWeb over the internet.
Results From the NWIS Web Command

Once the NWISWeb command downloads the data from NWISWeb, it creates a shapefile and adds it to the map (fig. 13). When it adds the new shapefile to the map, it sets the hyperlink setting so that when the hyperlink tool is selected and NWISWeb clicked on, it will open the site page from the NWISWeb website. Table 2 shows a list of fields that are populated for the shapefile from NWISWeb and their description.
Figure 13. Results of the retrieval from NWISWeb.
Table 3. Fields populated by the ArcGIS NWISWeb Extension.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency</td>
<td>Source Agency Code</td>
</tr>
<tr>
<td>SiteIdNo</td>
<td>Site identification number</td>
</tr>
<tr>
<td>StationNam</td>
<td>Local Number or Station Name</td>
</tr>
<tr>
<td>Latitude</td>
<td>Latitude (ddmmss)</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude (dddmmss)</td>
</tr>
<tr>
<td>LLAccCode</td>
<td>Latitude-longitude coordinate accuracy</td>
</tr>
<tr>
<td>LLDatum</td>
<td>Latitude-longitude datum</td>
</tr>
<tr>
<td>DDLat</td>
<td>Latitude in decimal degrees</td>
</tr>
<tr>
<td>DDLong</td>
<td>Longitude in decimal degrees</td>
</tr>
<tr>
<td>DDDatum</td>
<td>Decimal Latitude-longitude datum</td>
</tr>
<tr>
<td>RealTimeCo</td>
<td>Real-time data flag</td>
</tr>
<tr>
<td>DischBegin</td>
<td>Daily streamflow data begin date</td>
</tr>
<tr>
<td>DischEnd</td>
<td>Daily streamflow data end date</td>
</tr>
<tr>
<td>DischCount</td>
<td>Daily streamflow data count</td>
</tr>
<tr>
<td>PeakBegin</td>
<td>Peak streamflow data begin date</td>
</tr>
<tr>
<td>PeakEnd</td>
<td>Peak streamflow data end date</td>
</tr>
<tr>
<td>PeakCount</td>
<td>Peak streamflow data count</td>
</tr>
<tr>
<td>QWBegin</td>
<td>Water quality data begin date</td>
</tr>
<tr>
<td>QWEnd</td>
<td>Water quality data end date</td>
</tr>
<tr>
<td>QWCount</td>
<td>Water quality data count</td>
</tr>
<tr>
<td>GWBegin</td>
<td>Ground-water data begin date</td>
</tr>
<tr>
<td>GWEnd</td>
<td>Ground-water data end date</td>
</tr>
<tr>
<td>GWCCount</td>
<td>Ground-water data count</td>
</tr>
<tr>
<td>WebLink</td>
<td>URL to NWISWeb site page</td>
</tr>
</tbody>
</table>
Appendix 3

Tables Created by HObO

Head Observation Organizer (HObO) stores data in an ESRI ArcGIS personal geodatabase. The personal geodatabase is a Microsoft Access database. Although editing the tables in Microsoft Access or ArcGIS is possible, care should be taken to not damage the HObO database. HObO creates 13 main tables (table 3). These tables store both the spatial and tabular data. Of the 13 tables, 2 tables (HObOStudyArea and HObOWells) store spatial data. HObOStudyArea stores polygons defining the study area that are used to check wells when importing data. HObOWells stores well-point locations. The table HObOWL stores measured water levels and the flags assigned to the water levels. The remainder of the tables are lookup tables and parameters used by HObO.

Table 4. Tables created by HObO.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Data stored in table</th>
</tr>
</thead>
<tbody>
<tr>
<td>HObOImportDef</td>
<td>Parameters used for importing</td>
</tr>
<tr>
<td>HObOObservationDef</td>
<td>Parameters used for observations</td>
</tr>
<tr>
<td>HObOPrimaryLUT</td>
<td>Primary key and description</td>
</tr>
<tr>
<td>HObOProjectionInfo</td>
<td>Projection information</td>
</tr>
<tr>
<td>HObOProp</td>
<td>HObO properties</td>
</tr>
<tr>
<td>HObOSecondaryLUT</td>
<td>Secondary key and description</td>
</tr>
<tr>
<td>HObOSourceLUT</td>
<td>Source key and description</td>
</tr>
<tr>
<td>HObOStudyArea</td>
<td>Study area polygons</td>
</tr>
<tr>
<td>HObOWellComments</td>
<td>Well comments</td>
</tr>
<tr>
<td>HObOWells</td>
<td>Well points</td>
</tr>
<tr>
<td>HObOWellsLUT</td>
<td>Well key and description</td>
</tr>
<tr>
<td>HObOWL</td>
<td>Measured water-levels</td>
</tr>
<tr>
<td>HObOWLComments</td>
<td>Water-level comments</td>
</tr>
</tbody>
</table>